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True/False Questions
Each of the following statements is either true or false. Indicate your 
choice by circling T or F.

1. Paragraph styles can include both paragraph- and character-formatting 
instructions.

2. You can apply character styles to selected text within a paragraph.

3. You can use either the Styles task pane or the Quick Style Gallery to 
apply a paragraph style.

4. If you select only part of a paragraph to change the paragraph style, 
only the selected portion is reformatted.

5. You can create a paragraph style by changing the formatting of selected 
text, right-click the selection, and select Styles.

6. A style named and created for a specific document cannot be modified 
for that document.

7. When you delete a style from the style sheet, any paragraph or text 
containing that style returns to the Normal style.

8. You save the styles created for a document by saving the document.

Short Answer Questions
Write the correct answer in the space provided.

1. In the list of styles, which symbol designates a paragraph style?

2. In the list of styles, which symbol designates a character style?

3. How do you print a list of a document’s styles?

4. What is the purpose of a theme?

5. How do you display style names in the left margin of a document?

6. How do you open the Create New Style from Formatting dialog box?
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7. What are the five types of styles?

8. On which style are all standard styles based?

Critical Thinking
Answer these questions on a separate page. There are no right or wrong 
answers. Support your answers with examples from your own experience, 
if possible.

1. The Based on option is often used to create a group of heading styles 
based on one style and a group of body text styles based on another 
style. Why aren’t heading styles and body text styles typically based on 
the same style?

2. Create complementary styles for a heading and for body text, using two 
different fonts. Describe the formatting for each style, and provide a 
sample of the styles used together. Describe the type of document for 
which this combination would be suited.

Exercise 11-13
Apply styles and create new styles.

 1. Open the file Agenda - 1.

 2. Use the Quick Style Gallery to apply a style to the document title by 
following these steps:

a. Position the insertion point in the title (the first line).

b.  Click the More Arrow button  to open the Quick Style Gallery.

c.  Click Title.

 3. Use the Styles task pane to apply a style by following these steps:

a. Click the Home tab, and click the Styles Dialog Box Launcher to 
display the Styles task pane.

b. Position the insertion point in the next heading, “Sponsored by.”

c. Click Subtitle in the Styles task pane.

 4. Apply the Heading 1 style to the heading “Agenda.”

 5. Create a new paragraph style for a heading by following these steps:

a. Select the heading “Thursday, February 10.”

b. Click the New Style button , and key Day in the Name text box.

c. Change the font formatting to 14-point bold and small caps.
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d. Change the paragraph formatting to 12 points spacing before and 
6 points spacing after. Click OK to close the Create New Style from 
Formatting dialog box.

e. Apply the Day style to the line beginning “Friday.”

 6. Use the Create New Style from Formatting dialog box to create a new 
style for the agenda text by following these steps:

a. Position the insertion point at the beginning of the line that begins 
“12 Noon.” Click the New Style button  in the task pane.

b. Key Agenda Items in the Name text box.

c. Change the font size to 12.

d. Click Format and choose Paragraph.

e. Change the left indent to 0.25 inch, and change the spacing after to 
3 points. Click OK.

f. Click OK in the Create New Style from Formatting dialog box.

 7. Select all the agenda text under the headings “Thursday” and “Friday.” 
Choose the Agenda Items style from the Styles task pane.

 8. Apply the Heading 2 style to the line that begins “Grove City College.”

 9. Change the document title to small caps and add 72 points of spacing 
before the paragraph.

 10. Save the document as [your initials]11-13 in your Lesson 11 folder.

 11. Submit and close the document.

Exercise 11-14
Create, redefine, modify, and rename styles.

 1. Open the file OH Stores. Display the Styles task pane.

 2. Select the document title, and apply 14-point Times New Roman, bold 
italic format. Create and apply a paragraph style by right-clicking the 
selected text, and choosing Styles. Choose Save Selection as a New 
Quick Style, and name the style Office Heading.

 3. For the text “Campbell’s Confections,” create and apply a paragraph 
style named Subhead with the formatting 12-point Arial, bold italic and 
with 12 points spacing before and 3 points spacing after paragraphs.

 4. Position the insertion point in each line of text that contains a Campbell’s 
Confections’ store name, and apply the Subhead style (press F4  to repeat 
the style).

 5. Redefine the Subhead style by following these steps:

a. Select the first occurrence of “Campbell’s Confections,” and remove 
the italic format by clicking the italic button .

b. Right-click the Subhead style in the task pane. Choose Update 
Subhead to Match Selection.
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 6. Create a new character style for the word “Fax” by following these steps:

a. Position the insertion point at the beginning of the second telephone 
number for the Akron Office. Click the New Style button  in the 
task pane.

b. Key Fax Num in the Name text box.

c. Choose Character from the Style type drop-down list.

d. Click the Font Color down arrow to display the color palette, and 
change the color to dark blue.

e. Click Format, choose Font, and choose Small caps. Click OK. Click 
OK again.

 7. Key the word Fax: followed by a space at the beginning of the second 
telephone number for the Akron office. Repeat for the other five offices.

 8. Select the word “Fax” the first time it occurs, and apply the Fax Num 
style from the task pane. Apply the same style to each occurrence of 
“Fax” by selecting the word and pressing F4 .

 9. Rename the Fax Num style by following these steps:

a. Right-click the Fax Num style in the task pane, and choose Modify.

b. In the Name text box, edit the text to “Fax” and click OK.

 10. Delete the Office Heading style by following these steps:

a. Right-click the Office Heading style in the task pane.

b. Choose Delete Office Heading. Click Yes.

 11. Apply the Title style to the document title. Modify the style to include 
small caps. Delete the blank paragraph after the title.

 12. Change the top margin to 1.5 inches and the bottom margin to 0.5 inch.

 13. Key Telephone: followed by a space to the left of each telephone number 
for all offices. (The telephone number is the first number listed.) Apply 
the Fax style to the “Telephone:” text.

 14. Save the document as [your initials]11-14 in your Lesson 11 folder.

 15. Submit and close the document.

Exercise 11-15
Create styles, use style options, and display and print styles.

 1. Open the file Health Fair. Display the Styles task pane. Change the date 
in the memo heading to today’s date. Change the date in the third 
paragraph below the memo heading to a date two weeks from today’s 
date. Delete the instruction text.

 2. Select the text “Board Room No. 1,” and create and apply a new 
paragraph style named Room with the formatting 12-point Arial, with 
bold italic and with 3 points spacing after.

 3. Apply the new Room style to “Board Room No. 2” and “Board Room 
No. 3.”
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 4. Create a new paragraph style named “Session” that is based on the 
Room style by following these steps:

a. Position the insertion point after “Board Room No. 1” and press Enter . 
Key 30-Minute Sessions. Click the New Style button  on the Styles 
task pane.

b. Key Session in the Name text box.

c. Check that Style based on is set to the Room style.

d. Using the Formatting buttons in the Create New Style from 
Formatting dialog box, change the font formatting to 11 points and 
turn off bold and italic.

e. Click OK.

 5. Click at the beginning of the paragraph that starts with the word 
“Topics.” Create a new paragraph style named Info that is based on the 
Normal style. Use the formatting 11-point Arial, with 3 points of spacing 
after paragraphs.

 6. Assign Session as the following paragraph style for Room, and assign 
Info as the following paragraph style for Session by following these steps:

a. Right-click the Room style in the task pane.

b. Choose Modify.

c. Choose Session from the Style for following paragraph drop-down list.

d. Click OK. Repeat the procedure to assign Info as the following 
paragraph style for Session.

 7. Position the insertion point at the end of the heading “Board Room 
No. 2,” press Enter  to apply the Session style, and key 45-Minute Sessions.

 8. Press Enter  to apply the Info style and key Topics:.

 9. At the end of “Board Room No. 3,” press Enter , and key the following 
two lines of text:

30-Minute Sessions
Topics:

 10. Select the text from “CPR” to “First Aid,” and format the text as a 
bulleted list using a small square bullet (�). Right-click the selected text, 
and choose Styles from the shortcut menu. Click Save Selection as a 
New Quick Style. Name the style Content, and click OK.

 11. Select the two lines of text that follow “Topics for Board Room No. 2,” 
and apply the Content style. Repeat the style for the three lines of text 
under “Topics for Board Room No. 3.”

 12. Modify the Normal style to be Arial, with single spacing.

 13. Display the style area for the document by following these steps:

a. Open the Word Options dialog box, and click Advanced. Scroll to the 
Display group.

b. Set the Style area width to 0.5 inch and click OK. Switch to Draft view.

 14. Format the memo with the correct spacing at the top of the page, and 
remember to include your reference initials at the end of the document. 
Change the bottom margin to 0.5 inch.
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 15. Restore the style area width to zero. Switch to Print Layout view.

 16. Print the document style sheet by following these steps:

a. Open the Print tab.

b. Choose Styles from the Print All Pages drop-down list, and click OK.

 17. Spell-check the document, and save it as [your initials]11-15 in your 
Lesson 11 folder.

 18. Submit and close the document.

Exercise 11-16
Apply and customize document themes.

 1. Open the file Health Fair - 2. Display the Styles task pane.

 2. Change the document theme by following these steps:

a. Click the Page Layout tab, and click the Themes button .

b. Click the Median design from the Themes Gallery.

 3. Change the theme font by following these steps:

a. Click the Theme Fonts button .

b. Click Create New Theme Fonts.

c. Change the heading font to Tahoma, and change the body font to 
Tahoma.

d. Key Custom Font in the Name text box. Click Save.

 4. Modify the Normal style by changing the font size to 12.

 5. Apply the style Heading 1 to the first line of the document. Apply the 
Heading 2 style to the text that begins “Saturday.”

 6. Apply the Heading 3 style to the headings “Employee’s Full Name,” 
“Store Location,” and “Preferred Sessions.” Modify the Heading 3 style 
to 24 points spacing before and 3 points spacing after.

 7. Click the Page Layout tab if necessary, and click the Theme Colors 
button . Click Create New Theme Colors. Change the Accent 1 color 
to the last color in the fifth column, Ice Blue, Accent 1, Darker 50%. Key 
Custom Color in the Name text box, and click Save.

 8. Format the document with a 1.5-inch top margin.

 9. Spell-check the document.

 10. Save the document as [your initials]11-16 in your Lesson 11 folder.

 11. Submit and close the document.
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Exercise 11-17
Create, apply, and modify styles; print styles.

1. Start a new document. Key the text shown in Figure 11-15. Create the 
styles as indicated for the first two lines.

UNIT 3 Page FormattingWD-350

2. Apply the Headline 2 style to the last line of text. Modify the style to 
include 18 points of paragraph spacing before and after.

3. Create a style called Body 1 (based on the Normal style) for the 
remainder of the text; the style should be 12-point Arial, centered, with 
1.5-line spacing.

4. Center the document vertically on the page.

5. Click the Change Styles button  on the Home tab, and change the 
style set to Traditional.

6. Add a page border to the document.

7. Spell-check the document.

8. Save the document as [your initials]11-17 in your Lesson 11 folder.

9. Submit the document and the style sheet, and close the document.

Exercise 11-18
Create, modify, and rename styles; print styles.

 1. Open the file Screening.

 2. Create a character style named Memo Heading using Arial Black, 
12 points.

Figure 11-15
Health Screening Day

For More Information:

Garland Miller

Campbell’s Confections

250 Monroe Street

Grove City, PA 16127

800-555-2025

Campbell’s Confections—Makers of Fine Chocolate

New style: Headline 2 
18-pt Arial italic, centered

New style: Headline 1 
24-pt Arial bold, centered
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 3. Select “Memo To:” and apply the Memo Heading style. Repeat the style 
formatting for “From:,” “Date:,” and “Subject:.”

 4. Select the four lines in the memo heading, and adjust the tab setting to 
1.25 inches.

 5. Modify the Normal style to include 12-point Times New Roman and 
12 points spacing after.

 6. Select the text beginning “Height and weight” through “Asthma 
screening,” and format the text using a picture bullet.

 7. Rename the style Memo Heading with the name Memo Head.

 8. Position the insertion point in the subject line of the memo heading, 
and change the spacing after to 24 points. Add a bottom border to the 
subject line.

 9. Change the top margin to 2 inches and the bottom margin to 0.5 inch.

 10. Add your reference initials to the document.

 11. Save the document as [your initials]11-18 in your Lesson 11 folder.

 12. Submit and close the document.

Exercise 11-19
Modify styles, use style options, and print styles.

 1. Open the file Property - 2.

 2. Format the document as a letter to the name and address shown below, 
from Lynn Tanguay, vice president. Remember to use the correct top 
margin and spacing and to include your reference initials. Change the 
bottom margin to 0.5 inch.

Dr. James Wenner
West College
PO Box 1000
New Wilmington, PA 16172

 3. Edit the first line of the letter to read:

Thank you for agreeing to present a seminar on property insurance for 
Campbell’s Confections’ store owners/managers. Please discuss the 
following topics.

 4. Select the text “Types of insurance,” and create a style named Topic with 
12-point bold and small caps formatting.

 5. Position the insertion point at the end of the document, and create a 
new style named Subjects with 12-point formatting.

 6. Modify the Topic style by changing the style for following paragraph to 
Subjects.

 7. Position the insertion point at the end of the line “Types of Insurance.” 
Press Enter  and key the text shown in Figure 11-16.
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 8. Apply the Topic style to the text “Types of Coverage,” press Enter , and 
key the following items. Place each on a separate line, and omit the 
commas.

Fire, Theft, Catastrophes, Accidents, Loss of Income

 9. Press Enter  twice after keying “Loss of income,” and apply the Normal 
style.

 10. Key the following closing paragraph.

If time permits, you may want to include comments on how to select an 
insurance agent. We look forward to your presentation next month.

 11. Key the closing lines of the letter.

 12. Modify the font size of the Normal style to 12 points.

 13. Spell-check the document.

 14. Save the document as [your initials]11-19 in your Lesson 11 folder.

 15. Print the style sheet and the document, and close the document.

Exercise 11-20  Challenge Yourself
Create, apply, and modify styles; apply themes.

 1. Open the file Ordering. Display the Styles task pane.

 2. Apply the Opulent theme to the document.

 3. Apply the Title style to the first line of the document.

 4. Position the insertion point in the “Online” paragraph. Create a style 
called Side Heading using 14-point bold and small caps formatting.

 5. Apply the Side Heading style to each of the document side headings. 
(There are seven side headings.)

 6. Position the insertion point in the paragraph that begins “Note,” and 
create a new style named Special Note using 11 points and 0.25-inch 
left indent.

 7. Apply the Special Note style to each “Note” paragraph and the 
paragraph that follows “Note.”

Figure 11-16 Equipment

Inventory

Buildings

Land

Liability

Business Interruption

Key Employees
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 8. Modify the style of the Normal font to 11 points.

 9. Modify the Title style to small caps.

 10. Create a left-aligned header for page 2 to include the following text. 
Place two blank paragraphs after the second line of the header.

Place an Order
Page [Number]

 11. Add a bottom border to the page number paragraph in the header.

 12. Add your reference initials to the bottom of the document.

 13. Save the document as [your initials]11-20 in your Lesson 11 folder.

 14. Print the document and the style sheet, and close the document.

In these exercises you work on your own, as you would in a real-life 
business environment. Use the skills you’ve learned to accomplish the 
task—and be creative.

Exercise 11-21
Create a one-page newsletter with three or four articles. Create and use 
styles for the different newsletter elements, such as the title, date line, body 
text, and publisher information. Save the document as [your initials]11-21. 
Submit the document and the styles.

Exercise 11-22
Assume you have been on a job interview. Write a follow-up letter for the 
interview. If necessary, use the Internet to locate guidelines for appropriate 
content. Compare the document appearance by applying three different 
themes. Select an appropriate theme and document styles for your letter. 
Save the document as [your initials]11-22. Submit the document and the 
styles.

Exercise 11-23
Create a document that includes your five favorite songs. Each song should 
appear as a three-line description—song title, songwriter, and performer—
with each line using a different style. The songwriter and performer styles 
should be based on the song title style. Specify the songwriter style as the 
style following the title style, and the performer style as the style following 
the songwriter style. Create the styles first; then key the text. Modify the 
styles as desired. Save the document as [your initials]11-23. Submit the 
document and the styles.

On Your Own
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